
IBM NETCOOL OMNIBUS 
Install and test in less than 1 hour! 

 

     NetCool Omnibus is a key component in IBM’s event management solution and 
service management infrastructure.  Although there are several NetCool products 
required to build a small test environment, it can be built in less than an hour by 
following a few simple steps.  This article will walk you through the steps required to 
set up a simple management server and one or two probes for testing.  The information 
required to install Omnibus and the WebTop browser based interface are available with 
the products but some of the key information is spread across several documents.  This 
paper is a quickstart guide on how to install and test Omnibus and WebTop in a short 
period of time for testing purposes.   

Hilon Potter, IBM Executive IT Specialist 
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IBM NETCOOL OMNIBUS 
Install and test in less than 1 hour! 

Within any IT Infrastructure there are multiple devices, from 100’s to 1,000’s, depending on the size of the enterprise.  These 
devices include everything from the facilities, power and cooling components, to storage, servers, and networking equipment.  In 
addition, there are operating systems, middleware and applications executing thousands of transactions a second.  During the 
execution of these transactions all of these components generate “events”, some by writing to logs, others by generating messages 
to supporting servers.  In order to easily manage and monitor all of these events you need a solution that consolidates all of your 
enterprise events into a fewer manageable repositories, and an easy to use graphical interface.  NetCool Omnibus is an example of 
one of those solutions.  The events gathered can be error conditions, alerts, or simply the device is starting or stopping.    

The three main components are the repository and server that manages it (NetCool Omnibus ObjectServer), a graphical interface 
(NetCool WebTop), and the individual probes (NetCool Omnibus 
Probes) on each of the components being monitored.  This is the 
simplest configuration.  In reality, you would design a more 
hierarchical solution.  There can be lower level ObjectServers that 
collect and handle events for specific types of components, i.e. 
networking, servers, and applications.  These would then surface 
critical events to a higher level server that would integrate them in a 
single interface.  For more information on NetCool Omnibus please 
refer to the online product information and guides at 
http://www.ibm.com/software/tivoli/products/netcool-omnibus/  

Setting up a simple test environment is neither difficult nor 
complicated.  As the title implies, you can set up a small test 
environment in roughly an hour by following some simple steps.  The 
following sections will help lead you through the installation process and configuration.        

 

Figure 1
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OVERVIEW 
There were actually two base server environments that were used for testing.  They included both a Windows 2003 Server and a 
Windows XP environment.  Although the base server is supported on multiple hardware and operating systems, Windows was 
chosen because it could be set up on a desktop configuration for quick testing.  The actual production environment would be 
chosen based on several functional and non-functional requirements.  The base management server has three software packages 
that need to be installed.  The NetCool Omnibus ObjectServer and base components, the NetCool Security Manager, and the 
NetCool WebTop graphical interface.  The versions used in this test were as follows: 

• NetCool Omnibus Server version 7.2.1 
• NetCool Security Manger 1.3 
• NetCool WebTop 2.1 
• NetCool Omnibus syslogd probe for Windows 

It is assumed that you have the install packages for the above four products for Windows 2003/XP.  The base configuration you 
will be setting up is shown in Figure 1.  It’s also assumed that you will be installing the first three components on the same server 
for this initial test.  There are other probe’s that will work and can be easily added to this test environment, but Windows syslogd is 
an easy one to set up for an initial test.  

STEP 1- INSTALL THE BASE SERVER  
Insert the NetCool Omnibus for Windows Install CD or you can copy the install packages to the target server.  You have a choice 
to install the base code using a GUI interface or a silent install.  Until you have gone thru the install process several times and 
understand all the options and the features you will need to install on the various platforms, I suggest you use the GUI interface.   

To start the install of the base server just execute the Setup.exe 
file in the install package.  You will be prompted to accept the 
license (select yes) and the target directory for the install.  You 
can use the defaults at this time.  You will be prompted for the 
features you want to install.  The popup dialog box should look 
like the one in Figure 2.  The minimum you will need to install 
for a simple base server is the Desktop, Servers, Confpack, 
Administrator, and Local Help System.  When the dialog box 
opens up all features will be checked to be installed.  You can 
simply use the mouse and right click on the features you do not 
want to install and select remove.  You can re-run the setup 
program and add or remove features at a later time.  Once you  
have selected the features listed at the right, just hit next. 

This will install the base code using all the defaults settings.  
You will need to manually reboot the server after the base install.  The other installs of the security 
manager and WebTop will not require a reboot.  The base install just completed included defining a base 
ObjectServer and creating an administrator userid.  These will be sufficient for your initial testing.  The 
key pieces of information that you will need for the following steps are: 

• DNS name of the server 
• ObjectServer name and listening port: NCOMS at port 4100 
• Default admin userid is root with no password 

The next thing you need to do is initialize the NCOMS repository.  Bring up a Windows command prompt and navigate to the base 
install directory (i.e. C:\Program Files\IBM\tivoli\Netcool\omnibus\bin”).  If you identified a different location, then navigate to 
the bin directory in the base omnibus install location you have chosen.  Then issue the command nco_dbinit.  This command is 
driven by a base properties file and any properties you pass to it.  All the defaults are defined to work with the NCOMS repository.  
You should see several messages as the database is initialized.  The next step is to set up the ObjectServer as a Windows Service.  
In the same directory as the command to initialize the repository is a command to register the ObjectServer as a service.  Just issue 

Figure 2
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the command nco_objserv /install.  You should see a set of messages that the service is being installed and receive a final 
message: 

The Netcool/OMNIbus Object Server service was successfully installed 

You’re almost done with the base install.  You just need to start the service and verify the install.  Navigate to the Services 
interface by selecting the Windows Start bar -> Control Panel -> Administrative Tools -> Services.  The services window should 
open.  Scroll down till you find the 
NetCool/OMNIbus Object Server and select it 
using a right mouse click.  It should look like the 
picture in Figure 3.  Highlight Start and hit the left 
mouse button.  This will start the service.  If you 
want to set it up to automatically start when 
windows starts, right mouse click and select 
properties.  Then change the Manual start option 
to Automatic.  Now that the service is started, all 
you have to do is test it.  Select the Windows Start 
button, then All Programs.  There should be a new 
program entry titled NetCool Suite.  Select that 
entry and the Administrative program.   

The administrative interface will start and you will see a standard Windows program GUI.  You should see two child windows in 
the work area.  Select the ObjectServers window by simply selecting the title bar.  There should be one entry for NCOMS.  Just 
double left click on the name and a logon popup should appear.  Enter the userid root with no password and hit the Ok button.  
You will be logged in and a new window will appear with the NCOMS server details.  If you get an error message that the server 
is not running go back and verify that the service is actually started, using the Windows service interface you used in the previous 
step.  Assuming that you were able to log on, this verifies that the server is running.  If it has failed, please consult the Omnibus 
Installation guide you received with the install packages, before proceeding to the next step, for assistance with debugging the 
install.  Once verified, you can close the administrator application.   

STEP 2 – INSTALL THE SECURITY MANAGER  
The security manager is required to authenticate users and 
define the user entitlement when using the WebTop 
browser front end.  The install process on Windows is 
started by running the Setup.exe program from the 
Security Manager install media or directory.  You will see 
the standard welcome screen.  You will need to accept the 
license and the default install directory and then you will 
see a popup window for the Security Manager Server 
configuration (see popup in Figure 4).  You can accept the 
defaults but write them down, then hit the Next button.  
You will need the hostname and the Server port (8077).  

Both pieces of information will be needed when you 
install the WebTop GUI interface.  

Figure 3

Figure  4
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The next popup is the location of the ObjectServer you installed in step 1.  The host name should be the same as you wrote down 
in the step above, if not, change it to the name you wrote 
down.  Assuming you haven’t changed the port or 
useid/password, it’s the default of 4100 and root with no 
password.  Then just hit the Next button.  The next popup 
will ask you what registry to use for the authentication 
server.  Just select the radio button for the NetCool 
Omnibus Server if it is not already selected, and hit Next 
(sample not shown). 

 

 

The next popup you will see is the one to the right.  Since 
you are not using an external registry, DO NOT check the 
Use Application Registry checkbox.  If you do it will cause 
the security server to fail.  Just leave it unchecked, or if it is 
checked, uncheck it and hit Next.  Just continue with the 
install till it is complete.  It will install all the components 
necessary and setup the Security Server as a Windows 
service.  You just need to follow the same instructions as in 
the previous step to start the service. 

Navigate to the Services interface by selecting the 
Windows Start bar -> Control Panel -> Administrative 
Tools -> Services.  The services window should open.  
Scroll down till you find the NetCool Security Server and 
select it using a right mouse click and Start.   Highlight 
Start and hit the left mouse button.  Once complete the 
installed and started, the server will be running with the 
default settings including the default Security Manager userid/pw of admin/netcool.  

STEP 3 – INSTALLING THE WEBTOP GUI INTERFACE 
NetCool WebTop is actually made up of two components, the NetCool GUI Foundation and the actual WebTop application.  The 
WebTop install process will actually install all the components in a single process.  Insert the install media or navigate to the 
WebTop install directory and run Setup.exe.  You should see a welcome 
screen (with WebTop in the title).  Just select the next button, accepting the 
license agreement and the default target install directory.  You will then get 
the features selection popup (see the image to the right).  The only feature 
you neeed to install is NetCool/WebTop.  You can right click on the Migrator 
and WAAPI and select remove, you only need those when migrating from a 
previous version.  Then hit Next. 

 

 

 

Figure 5

Figure 6

Figure 7
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You will then get to a series of popups, where you will input all the defaults 
settings from the previous installs.  First the ObjectServer, the default server 
name is NCOMS, hostname is the same server dns name, a port of 4100, and 
a username of root with no password.  All these defaults should be already 
entered in the popup, if not just enter the data and hit Next. 

 

 

 

 

 

The next popup will ask you for the location and port for the 
Security Manager and then the userid and password.  In the 
previous step you should have accepted the defaults.  That means 
the host is the same dns name as the other servers and the port is 
8077.  The userid and password is admin and netcool.  Hit Next 
in each popup as you enter the information in the popups. 

 

 

 

 

 

The last pop you will need to enter data into is the actual ports that the GUI Foundation will listen on for HTTP requests.  The 
defaults should be the ones listed in the example on the right.  If they are not, just change them to match and hit Next.  Then at the 
summary window just hit the Install button.   

All you need to do is start the GUI Foundation service and all 
the installs on the management server are complete.  Just 
navigate to the Services interface by selecting the Windows 
Start bar -> Control Panel -> Administrative Tools -> Services.  
The services window should open.  Scroll down till you find 
the NetCool GUI Foundation Server and select it using a right 
mouse click and Start.    

 

 

 

Figure 8

Figure 9

Figure 10
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All the servers should now be running.  To test them and setup a monitoring id, bring up a browser on the same machine or another 
machine connected to the same network.  Put in the URL of the server and the port i.e. http:/dcx13.pok.ibm.com:8080 and hit 
enter.  The DNS name is the complete server name you used during the install complete with the network suffix added.  If your 
server does not register it’s name in the DNS server you can use 
the ip address instead.  The port is the port you used above when 
you did the WebTop install.  

You should get the NetCool WebTop logon screen => 

Enter the userid admin 

And password of netcool (depending on how it was typed in, it 
may be NetCool). 

And hit the Login button 

 

 

Once logged on you will get the default admin homepage.  On the right there will be a pulldown with the default of 
Desktop.  Use the pulldown and select Administration. 

What you want to do, is create a userid that you can use to browse 
the events that are being captured by the server.   
Select the Security Tab and then the add user button.  There will be 
three tabs in the input area.  User Details, User Roles, and User 
Groups.  In the User Details tab section make up a userid i.e. tester1 
and a password for this user.  The Last name and password fields 
may be filled in because of the way the browser saves and caches data.  Just clear them out and enter the date you need.  Then 
select the User Roles tab.  In this section select the WebTop User in the left list and hit the Add button.  Then just hit the save 
button.  You should see the new user in the list of userids.  Now just logout (upper right of screen).  You should now be able to 
logon using the new userid and password you just created.  Once logged on the pulldown on the right should have WebTop 
Desktop as an option.  Just select it and you should see the default desktop.  Select the Events list and you should see something 
like Figure 13 (The browser will have to be Java enabled). 

You now have a fully working NetCool Omnibus server ready to have probes start reporting events to.  

Figure 11

Figure 12

Figure 13
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STEP 4 – INSTALLING A PROBE  
In this step you will setup a simple syslogd probe on a windows client or server.  The process is similar to step 1, in the sense that 
you will have to install a base server (with fewer features) before installing the probe.  
The actual probe is installed like a patch to a base server.  You start with the same install 
package as you did in step 1.  Follow the same instructions but when you get to the 
Feature selection, remove everything but Administrator and Confpack.  When you use 
the GUI install on a Windows server, it installs the probe base code under the covers.  If 
you do a silent install on on another server you will have to select installing the base 
probe support.  Keep hitting the Next button till you get the final Install and complete 
the install.  The next step is to install the sysd probe as a patch.  There is no install 
program or interface for the probe.  All you do is unpack it and copy the directory 
structure to the default probe location for a win32 platform 

 i.e. C:\Program Files\IBM\tivoli\Netcool\omnibus\probes\win32.      Figure 14

All you have to do now is configure the probe and start it as a service.  To configure the probe you need to edit the sql.ini file in 
the install directory for NetCool.  Navigate to C:\Program Files\IBM\tivoli\Netcool\ini and select the sql.ini file to edit using 
Wordpad.  Change the NCOMS entry to the dns name of ip address of where you setup the NetCool and Omnibus server and the 
port number.  The one to the right uses the default port of 
4100 and the dns name of the server I installed the 
ObjectServer on.  Then just save and close the file.  You now 
need to import the changes into the configuration.  Select the 
Windows Start button, then All Programs.  There should be a 
new program entry titled NetCool Suite.  Select that entry 
and the Administrative program.  The administrative 
interface will start and you will see a standard Windows 
program GUI.  It may ask you to import the settings, if it 
does just select the NCOMS entry at the server name you just 
modified and move it to the right table to be imported and 
finish the import.  You can then close the Admin interface.  
If it didn’t prompt you to import the changes, then select the 
File->Import function from the action bar and complete the 
install.  Don’t forget the default user/pw is root with no 

password.  Once imported all you have to do is register and start the server.  Navigate to the probe directory 
and issue the command nco_p_syslogd.exe –install.  This assumes you are installing the syslogd probe on a 
Windows machine.  You will find a Readme file in the probes directory with more complete details on registering the probe.  Now 
just go to the Windows Control panel and services like the steps above and you should find a NetCool syslogd probe that you can 
right click and start.  Once started you should be able to log onto the WebTop server (end of step 3 above) and see an entry in the 
events list for the probe you just started. 

Figure 15

CONCLUSION 
This test is simply the tip of the iceberg.  You can install probes on many different devices, servers, operating systems and 
middleware products.  Once installed you can configure filters, assign owners to events and create a very optimized and robust 
event processing solution.  This is only a part of a more complete Service Management environment.  An Onmibus management 
server can be enhanced with NetCool Impact to provide autonomic processing of events and The Tivoli Integrated Portal and be 
configured to include the events processed by Omnibus.  There are multiple user and Administration guides online, for additional 
information on setup and configuration please consult the online documentation at  
http://www.ibm.com/software/tivoli/products/netcool-omnibus/.   

http://www.ibm.com/software/tivoli/products/netcool-omnibus/

